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Objective

To determine the Advanced Smoke analysis is able to capture the violation of
Current, Voltage, Temperature and power dissipation for all circuits.
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SMOKE ANALYSIS

Smoke analysis is an Advanced analysis in PSPICE, which is technically termed as Stress
Analysis and It’s not a worst case analysis.

Smoke warns of component stress due to power dissipation(PDM), increase in junction

temperature(Tj), secondary breakdowns(Tb), or violations of voltage / current limits.

Smoke analysis compares the simulation values with the rated values given for the
component and if it exceeds the rated value, it will be highlighted in red colour. In case of
failures, you need to change the component and Re-run the simulation.

Spreadsheet analysis is a manual stress analysis to calculate Current, Voltage, Power and
Temperature of all components.
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Advantages and Limitations of Smoke Analysis

Advantages:

e Easy to simulate even complex circuits.

* Manual calculation error can be neglected.

e Overall circuit knowledge is sufficient to run the simulation.

e Derating can be applied to all components parameter as per the requirement and
those derating values are not interlinked (i.e., PDM derating is not Interlinked with Tj
derating value)

* One time effort itself sufficient for Custom derating, if your are going to use same
derating factor.

e By giving extra derating to components, we can overcome the worst case.

* Less time to compute the circuit.

* Smoke capture the Transient peak voltage, current, PD in “PEAK” type and It has the
Average and RMS as well.

Limitations:
e Circuit cannot take the Component tolerance for smoke analysis, So it will not able to

compute Worst Case.

e “Parts” other than this cannot be covered under smoke Analysis and IC’s Cannot be
covered under smoke analysis.

* If Specific Parts PSPICE library file is not available in Website, You need to go for
alternative.

* “Smoke parameter” other than this cannot be added.
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Case Studyl:

Analog circuit.

Circuit Contains 34 passive components and 6 active components.

Out of 6 active component, 4 were readily available in PSPICE Advanced library and 2
downloaded from site.
Out of 34 passive components, 3 diodes .lib files downloaded from site.

Comparison of Tool based Advanced smoke analysis and spreadsheet

based Manual analysis.

S.no |Advanced Smoke Analysis Manual Analysis

1 Time Taken for analysis is 8.5hrs Time Taken for analysis is 2days.

2 Basic knowledge is sufficient to run the |In depth knowledge of circuit is required to do analysis.
simulation.

3 Easy to simulate even for complex Difficult to calculate for complex circuit.

circuit.

Time Taken for the Advanced Smoke analysis is given in below table.

S.no. |Task Time(hrs)
1 Downloading .lib files 0.5

2 Part Creation 0.5

3 Adding Smoke Paramaters. 2

4 Circuit Creation 3.5

5 Derating Factor Table Creation 1

6 Adding Derate type to the specific Part |0.5

7 Simulating PSPICE and smoke analysis |0.5
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Intentionally introduced Fault into the circuit to
check whether the tool detects the fault or not:

Before Introducing fault into the Circuit

1. Mosfet(Q4):

04 I Average 115m 100 115m 2.5815m 3
04 POM Average 200m 100 200m 350.4015u 1
Q4 Tl Average 150 100 150 27 19
Q4 VDG Average 6l 100 60 1.1372 2
Q4 VD5 Average 60 100 60 48871
Q4 VGESF Average 20 100 20 3.74499
2. Resistor(R5):
RS POM Average 250m a4 210.7675m 5.4825m 3
R3 TB Average 200 100 200 31,3850 16
After Fault
1. Mosfet(Q4):
04 o Average 115m 100 115m 231.6755%m
04 POM Average 200m 100 200m 170.8524m
04 Tl Average 150 100 150 27
04 VDG Average 60 100 0 1.614%
04 VDS Average 60 100 0 5.3666
04 VGSF Average 20 100 20 3757
2. Resistor(R5):
Ra FOM Average 250m 0 0
RS TB Average 200 100 200
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Smoke Analysis Procedure:

1. From your Design Entry CIS, Open your circuit or Create a new one from File menu
New -> Project, Select “Analog or Mixed A/D” and Create a Blank Project.

X Place Part L T x

[?’ & Part Q @
1A NyveT3a03
14

2. Use advanced analysis library (<Target

_directory> \ Capture \ Library \ N v
PSpice \ AdvAnls\) Parts for o EE§E§E1:ME:EE:_:E g
simulating Smoke Analysis and for NCELSPE. 166 TOOLS\CAPTURN ERARY\PSPICE\MOTOR_RF.OLB
Source(Vdc, Vac), you can use normal 4% 5
pspice library (<Target_directory> \ v ®
. . <=
Capture \ Library \ PSpice \Source).
[ |
o T oy
3. When you download .lib file from
manufactu rer Site’ Use MODEL ddd.LIB:ddd - AMS Medel Editor - [Model Te
. IEE #0 Edit  View Model Plot Tools %
EDITOR to create a part from .lib £ 1] New CtrieN
file. From File menu, Open the .lib i e
. H . Y kd Save Ctrl+5S
file and click Export to capture library M sove ..
to create the part. " Bl CtrieP
P'ag-;e Se:‘:;r_:
| Export to Capture Part Library...
Medel Import Wizard [Capture]...
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4. Select the Part which you created from .lib file, Place Part -> Add library(Alt+A).

: Place Part - =

B D
|

g

L)

MNCEVSPE_16.68TOOLS\CAPTURESBRARYYWPSPICENMOTOR_RF.OLE

5. Search Parts Under Part Box and add to circuit.

AEEEEEEEEEN :Piacepmt 4 -
% Q Part H-+ (2
1T A
. 35_1' Fart LIzt U
A @ [BREssAFDIO A
# e | |BBYS102w/RFDID
4 — | BEY5103w/RFDIO

BEY5202w/RFDID
1 <% | eevsa0aw/RFDID

BEY5302w/RFDID
4 ¥es | |BBYS303W/RFDID

BCT07/BJN v
1 T [mal
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using “R”.

7. From PSPICE menu, Select New Simulation and Create.

Mew Simulation >
Hame:
I |
Cancel

Inhent From:

[glalgl=) s

Root Schematic:.  SCHEMATICT

which you used to create part.

Simulation Settings - add Simulation Settings - add

G | Analysis  Configuration Fil Opti Data Collecti F _—_
ELEE igurstion Files - Uptions = - General Analysis Corfiguration Files  Options Data Collection  Probe Window

Analysis type: Details
gl i g ime: Category: )
e Domain (Transiont). Rur to bime: 1000nz . Ql_ﬁ’ Fiename:
) timulus
Options: Start zaving data after: (0 | ‘

Transient options Include Configured Files X| fl $

General Settings
[JMarte Cado/Warst Case

[JParametric Sweep
[CJTemperature {Sweep)
[]5ave Bias Poirt
[JLoad Bias Pairt

b amimnunn step size: I:I

[ 5kip the initial transient bias pc

] Bun in rezume mode

.'C ‘\Cadence\SPE_16.6'tools" pspice \ibrary\nom it

Add to Profile

Draw Wire(w) using L this symbol, Gnd(g) using # this symbol and rotate parts

Select Transient analysis under Analysis menu. Browse & Add the .lib file to design
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9. Each and Every component in the smoke analysis must have smoke parameter
specified, For downloaded components right click -> Edit PSPICE Model -> From
MODEL menu select “ADD SMOKE” to the Active Components and for Passive
components right click on the component -> Edit Properties. Click “Parameter” to

see the default smoke parameters for the Passive Components.

1SMB59323BT3.LIB: 1smb5933bt3 - AMS Madel E
B File Edit View

EEE RS *
Copy Erom... r
Models List | Add Smoke... i

Flot Toolz Win

10. Select the Component from Device Type drop down menu.

Medel Mame Typ
1smb53933bt3  SUBC

|IBIS Translator...

Import...
Export...

Add Smoke...

Device Type:

pi
e

i8]

Bipolar Transiztor

Ins Gate Bipolar Tran
Junction FET

Operational Amplifier
MOSFET[Power MOSFET]
“foltage Regulator
Drarlington Tranzistor

LED

Zener Diode

“fariztor

Dliode Bridge

Gads MESFET

T hyristor
“Yoltage-Controlled Switch
4 Pin OptoaCoupler
MNPMN-FMHP

MNMOS-FrOS

Drual BAT

Dal MOS

Transfarmer

=

Cancel

Help

—-20 N=1 XTI=1 RES5:
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11. Add the Smoke Parameter for the Transistor and save. Similarly add smoke
parameter for other components as well. Please click “Smoke Paramater” to see the
parameters to be filled for different components and verify the smoke parameters in
advanced library with datasheet before proceeding the simulation.

Smoke Parameters

Theze are Device b aximum Operating condition parameters
required for Smoke Analysis

Device Max Ops Description Value Unit
=] Max base current A
IC Max collector current A
WCB Max C-B woltage W
YWCE Max C-E voltage W
VEB Max E-B voltage W
PO Max pwr dissipation W
T4 Max junction temp C
RJC J-C thermal resist chanv
RCA C-A thermal resist chn
SBSLP Second brkdown slope

SBINT Sec brkdwn intercept A
SBTSLP 5B temp derate slope YT
SBMIN SB temp derate at TJ e

12. Run a PSPICE simulation as Time Domain (transient) analysis (Smoke does not work
on other types of analyses, such as DC Sweep or AC Sweep/Noise analyses).

OrCAD Capture - [/ - (SCHEMATICY : PAGET]]
@ File Design Edit View Tools Place 5lAnalysis

LT1E37
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13. Run a Smoke analysis from PSPICE -> Advanced Analysis -> Smoke. Smoke Output

window displays, how much the component stressed in the circuit.

B SCHEMATICT - AMS Advanced Analysis - [Smoke] - m} *
File Edit View Run Analysis Window Help _ & x
H E = 2 Smake ~ | asdf sim ~ 6
Smoke - agdf.sim [ Derating File: DERATE.drt ] Component Filter = [ *] -
+ | Component | Parameter Type Rated Value % Derating Max Derating Measured Value % Max
¥R POM Average 250m 59 148.5000m 1.5000m 2
¥ | R1 T8 Average 200 100 200 81.2000 41
¥ |R2 POM Average 250m 59 147.7500m 2.2500m 2
¥ |R2 B Average 200 100 200 81.8000 4

14. Green Bars shows that the component are within the safe operating limits, Red bar
indicate value that exceeds the safe operating limits and Grey bar indicate limit is not

valid for the parameter.

15. Right Click on the smoke analysis window to select type such as Average, Peak and
RMS value of each parameter.

16. Right click on the smoke analysis window and select the “DERATING” from the pop-
up menu.

17. Select one of the three from derating options on the pull right menu:
- No Derating
- Standard Derating

- Custom Derating

Copyright © 2017 HCL Technologies Limited | www.hcltech.com



18. To create a new derate file, Click the custom derating file button.

| Custom Derating Files;

19. Add the Derate type, category, factor and value in the block and similarly add other
derate type as per your requirement and save the file.

Edit Derate File

=
Derate File:
Derate Types Drerating Factors
x| 24
Derate Types Device Category | L Factor Value L]
myderate RES | PDM “w [ 55
Click here to add derate type | Click here to add derating factor

20. To use the custom derate file, In the Property Editor, add a new property for
the component with the name DERATE_TYPE and value same as the Derarte Type
specified, such as myderatetype. Select the corresponding derate file and run smoke.

E SCHEMATICT - AMS Advanced Analysis - [Smoke]

- O s
File Edit View Run Analysis Window Help - F x
”T" E = Iﬁ £ Smoke ~ | azdf.zsim w 6
Smoke - asdf.sim [ Derating File: DERATE.drt ] Component Filter = [ *] -
+ | Component| Parameter Type Rated Value % Derating Max Derating Measured Value % Max
¥ |R1 POM Average 250m 55 137.5000m 48375m
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Alternate method to fill the parameters for Project
specific Components

1. Select your Project, From TOOLS menu -> Export Properties and save it.

ﬂ OrCAD Capture - [dhusers\dayyansheriff. gl desktopinew folderine Texport Properties s |
B File Design Edit View [ Place Sl Analysis  Macro ]
- Scope
- ~ | WF Annotate... 1
: |_L| [j E =l (®) E wport entire design or Librang
: 14 Back Annotate... ; Cariea]
s _ () Expart selection
|SCHEMATIC1-ans  ~|[;  Update Properties.. el
H Help
i i Test Bench » Contents .
: % % % =% [Design Rules Check... @ Par Pmpe_meg )
E (") Part and Pin Properties
StartPace [ dd.opi* [=] Create Netlist... () Flat Met Properties
Create Differential Pair...
kod
BH# Cross Reference... @;EE et Pronart
- . wport [hstance Properties
O3 File %8, Hierarchy InterSheet References.., _
- 5 ] () Export Occunence Properties
ED Design Resources [£ Bill of Materials...
-5 Add.dsn® Export File:
= - | Export Properties... Hpen 2l
=& gHEMM'C import Propertics [D:NUSERS'DAYYANSHERIFF GADESKTOPY| | Browse..
b P'A,GE'I"’ B "

2. Use Tab as delimiter while opening the .EXP from excel and change the parameters
for all components like DERATE_TYPE.

3. Save the file and Import the file into your project using Import Properties from
TOOLS menu.
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Appendix 1:

Copyright © 2017 HCL Technologies Limited | www.hcltech.com



17

withstand

Smoke User Passive Maximum Symbol Symbol Smoke Variable Table Default
Interface Parameter (Component Operating Property Name |Parameter Name Value
Name Condition
Cl Capacitor Maximum ripple CURRENT CIMAX 1A
cv Capacitor Voltage rating VOLTAGE CMAX 50V
Current Supply VOLTAGE VMAX 12v
Supply Max. voltage
v current source can
withstand
LI Inductor Current rating CURRENT LMAX 5A
Lv Inductor Dielectric strength |DIELECTRIC DSMAX 300V
Resistor Maximum power POWER RMAX 0.25W
PDM dissipation of
resistor
Resistor Slope of power SLOPE RSMAX 0.005W/degC
RBA* (=1/SLOPE) dissipation vs.
temperature
RV Resistor Voltage Rating VOLTAGE RVMAX -
Capacitor Temperature SLOPE of volt  |[CSMAX 0.005 V/degC
SLP* derating slope temperature
curve
TBRK* Capacitor Breakpoint KNEE CBMAX 125 degC
temperature
TMAX* Capacitor Maximum MAX_TEMP CTMAX 125 degC
temperature
Resistor Maximum MAX_TEMP RTMAX 200 degC
temperature
TMAX, TB .
resistor can
withstand
Voltage Max. current CURRENT IMAX 1A
VI Supply voltage source can

Copyright|

Default Smoke Parameter for passive components
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Smoke Parameter Table:

Smoke ParameterName and
SymbolProperty Name

Semiconductor Parameter/
OPAMP Parameter

Maximum Operating
Condition

B BJT Maximum base current (A)
IC BJT Maximum collector current (A)
PDM BIT Maximum power dissipation
(W)
Thermal resistance, Case-to-
RCA BJT . '
C J Ambient(degC/W)
Thermal resistance, Junction-
R BJT ’
JC J to-Case(degC/W)
SBINT BIT Secondary breakdown
intercept (A)
Derated percent at TJ
SBMIN BJT
(secondary breakdown)
SBSLP BJT Secondary breakdown slope
SBTSLP BIT Temperature derating slope
(secondarybreakdown)
T3 BJT Maximum junction
temperature (degC)
VCB BIT Maximum collector-base
voltage (V)
VCE BIT Maximum collector-emitter
voltage (V)
VEB BIT Maximum emitter-base
voltage (V)
IF Diode Maximum forward current (A)
PDM Diode Maximum power dissipation
(W)
. Thermal resistance, Case-to-
RCA D . '
C lode Ambient(degC/W)
. Thermal resistance, Junction-
R D '
JC lode to-Case(degC/W)
T3 Diode Maximum junction

temperature (degC)
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Smoke ParameterName and
SymbolProperty Name

Semiconductor Parameter/
OPAMP Parameter

Maximum Operating
Condition

VR Diode Maximum reverse voltage (V)

IC IGBT Maximum collector current (A)

IG IGBT Maximum gate current (A)

PDM IGBT Maximum Power dissipation
(W)
Thermal resistance, Case-to-

RCA IGBT . ’

c G Ambient(degC/W)

Thermal resistance, Junction-

RJC IGBT '
to-Case(degC/W)

T3 IGBT Maximum junction
temperature (degC)

VCE IGBT Maximum collector-emitter (V)

VCG IGBT Maximum collector-gate
voltage (V)

VGEE IGBT Ma>.<|mum forward gate-
emitter voltage (V)

VGER IGBT Ma>_<|mum reverse gate-
emitter (V)

ID JFET or MESFET Maximum drain current (A)

G IFET or MESEET Maximum forward gate
current (A)

PDM IFET or MESFET (I\\/Is;(lmum power dissipation
Thermal resistance, Case-to-

RCA JFET or MESFET Ambient(degC/W)
Thermal resistance, Junction-

R FET or MESFET '

)€ J or MES to-Case(degC/W)

TJ JFET or MESFET Maximum junction
temperature (degC)

VDG IFET or MESEET Maximum drain-gate voltage

\)
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Smoke ParameterName and

Semiconductor Parameter/

Maximum Operating

SymbolProperty Name OPAMP Parameter Condition
VDS JFET or MESEET Maximum drain-source
voltage (V)

Maximum gate-source voltage

VGS JFET or MESFET )
ID MOSFET or Power MOSFET |Maximum drain current (A)
IG MOSFET or Power MOSFET | V&Ximum forward gate
current (A)
PDM MOSFET or Power MOSFET x/@‘;"m“m power dissipation
Thermal resistance, Case-to-
RCA MOSFET or P MOSFET . '
C 0S or Power MOS Ambient(degC/W)
Thermal resistance, Junction-
R MOSFET or P MOSFET '
JC OS or Power MOS to-Case(degC/W)
TJ MOSEET or Power MOSFET | VXimum junction
temperature (degC)
VDG MOSFET or Power MOSFET x/)ax'm“m drain-gate voltage
VDS MOSFET or Power MOSFET |V&Ximum drain-source
voltage (V)
VGSF MOSFET or Power MOSFET |aximum forward gate-
source voltage (V)
VGSR MOSFET or Power MOSFET | V@XImum reverse gate-
source voltage (V)
T™ Varistor Peak current (A)
. Thermal resistance, Case-to-
RCA Vi . ’
C aristor Ambient(degC/W)
. Thermal resistance, Junction-
RJC Varist '
anstor to-Case(degC/W)
T3 Varistor Maximum junction
temperature (degC)
IFS Zener Diode Maximum forward current (A)
IRMX Zener Diode Maximum reverse current (A)

Copyright © 2017 HCL Technologies Limited | www.hcltech.com



21

Smoke ParameterName and

Semiconductor Parameter/

Maximum Operating

SymbolProperty Name OPAMP Parameter Condition
PDM Zener Diode Maximum power dissipation
(W)
: Thermal resistance, Case-to-
RCA Zener Diode Ambient(degC/W)
, Thermal resistance, Junction-
RJC Zener Diode to-Case(degC/W)
. Maximum junction
T Z D
J ener Diode temperature (degC)
IPLUS OpAmp Non-inverting input current
IMINUS OpAmp Inverting input current
IOUT OpAmp Output current
VDIFF OpAmp Differential input voltage
VSMAX OpAmp Supply voltage
VSMIN OpAmp Minimum supply voltage
VPMAX OpAmp MaX|m um input voltage (non-
inverting)
VPMIN OpAmp !\/Ilnlm_um input voltage (non-
inverting)
VMMAX OpAmp I\./IaX|m.um input voltage
(inverting)
VMMIN OpAmp Minimum input voltage

(inverting)
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Conclusion

Smoke analysis is a time saving one but it doesn’t take component tolerance so will not
be able perform Worst Case analysis.
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Cadence Support Team

Tolerance does not have any effect on SMOKE. Smoke is audit of current operating

conditions against rated specification under current operating and environmental
conditions.

Tolerance parameter places a role in Monte Carlo, Sensitivity analysis.
So, there is no effect of tolerance in SMOKE analysis.
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FAQ (Frequently Asked Question)

1.

Ans:

Ans:

Ans:

Ans:

Ans:

Ans:

Smoke Parameter other than listed can be added?
No, Smoke Parameter other than listed in “Table” cannot be added to the

Part.
IC’s can be covered under smoke analysis like Voltage regulator?
NO, Parts other than listed in “Table” cannot be covered under smoke analysis.

What to do, If PSPICE model is not available for the component?
You need to go for alternative part, If the specific part model is not available.

Does the analysis capture the transient peak value and if it does means your
result is wrong right?

YES, But it shows three value PEAK(Transient peak Value), Average and RMS as
well

Is Tj Derating interlinked with PDM derating?
NO, Both has separate derating factor.

Advanced analysis library smoke parameters need to be verified?
Yes, Sometimes Parameters would have updated in datasheet.
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You’'re Done!
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